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Adobe Acrobat DC

Accessibility (A11y)
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Adobe Creative Cloud for Faculty & Staff

e Adobe Creative Cloud software is now available for use (at no
additional charge) on all faculty and staff university-owned
computers, labs and classroom devices, and for all students.

* Please note that this deployment of Adobe software is not

available for use on personally-owned faculty and staff
devices at this time.

 Learn more about Adobe Creative Cloud for Faculty & Staff

* Adobe Reader is for viewing, printing, signing, sharing, and
annotating PDFs. Adobe Reader doesn’t have Accessibility
Adobe Acrobat DC checking tool.
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https://www.csun.edu/it/adobe-creative-cloud-faculty-staff

Open PDF files from Adobe Acrobat not Web Browser by default

Windows Mac

Edit View Go Window Help

New Finder Window #N
New Folder BN
New Folder with "Accessible PDF.pdf” ~3N
New Smart Folder

New Tab

» Save PDF files on desktop « Save PDF files on Desktop

e Right-click on PDF file, select « Select PDF (not double Ay Open i FR dobe Acobatapp aefau) (1507

Close All B Adobe Acrobat.app (15.006.30503)

Accessible

Open with, Choose another app click) e | Wtn st Cot80n
Rename  _ Books.app
. Compress “Accessible PDF.pdf*” * ColorSync Utility.app
* File tab, Always Open oupcas D G e veraary
e with, Other el it o | R
Add to Sidebar

Open with Adobe Acrobat DC
Print
T-Zip
CRC SHA

How do you want to open this file?
Delete Immediately...
Eject

Keep using this app

Find

Adobe Acrobat DC

@ Edit with Adobe Acrobat
ﬁ Combine files in Acrobat...

%% Send with Transfer.., Choose an application to open the document “Accessible PDF.pdf"

Other options

Move to Drophox i IO~ Bl Adobe Acrobat DC & Q

Ea Scan with Windows Defender... Google Chrome ) :
M Spirion > Favaritas - Bl Adobe Acrobat 2015 »
2 G B s |- Adobe Acrobat DC N S
; Microsoft Edge ox Sync [ Adobe After..ts CC 2018 » /- | Adobe Acrobat.app
Open with - Adobe Acrobat DC 9
— S B Google Chrome % Recents B Adobe Animate CC 2018 »
v e = o
[ Spirion Classification 5| [ Microsoft Edge Word E B Adobe Au_d;tmn cc 2018 »
Restore previous versions [ word Wa - E Angbe Brioge (C2018 k
T rv— = Desktop B2 Adobe Creative Cloud ~ »
earch the Microsoft Store
send to > —_—— ﬁ Look for an app in the Microsoft Store M Documents #l Adobe Drea..er CC 2018 »
T w B Adobe lllust...or CC 2018 »
© Downloads @l Adobe InCopy CC 2018 »
ilove anac - ) @l Adobe InDesign CC 2018 »
Locat
ocations
+/ Always use this app to open .pdf files : g Bl Adobe Phot..op CC 2018 »
¢ iCloud Drive = i

FEl nine mae

= - -
OK Enable: | Recommended Applications

Always Open With

Options ) Cancel




Tools Pane Set Up

n Adobe Acrobat Pro DC
File Edit View Window Classifications Help

£ 5

Fill & Sign Prepare Form
en b

[orer [

Protect & Standardize

Customize

= O

Action Wizard
E& Create PDF
E2 EditPOF

[ Export PDF

| Add Shortcut
Learn More

*

A

If this is your first time
setting up Adobe
Acrobat software

e Select Tools Tab

 Add Shortcut for
Accessibility

csun.edu/udc
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Adding Tools to Navigation Pane

These are the primary tools needed to create an accessible PDF:

Option 1: View > Show/Hide >Navigation > Option 2: On left pane, right-click to select
Tags and Content Pane Tags and Content Pane

File Edit View Window Classifications Help

Home  Tools Doc1.pdf x
File Edit indow Classifications Help
Home Rotate View » 'ﬁf @ a Bd G\
Page Navigation »
i =4 » 000 (= On left pane
Page Display » ) ) E
Zoom . 0 right-click to select
Content and Tags
Tools @
Panels
‘I Show/Hide I Navigation Panes Ul Articles
Display Theme | v Tools Pane Shift+F4 @ Attachments UL Articles
IE Toolbar ltems I Bookmarks @ Attachments
Read Mode Ctrl+H
Cl Page Controls ‘ D Content l Bookmarks
Eull Screen Mode Ctrl+L I
v Menu Bar (®) Destinations B Content
EC;D Tracker... @ Layers Destinations
Button Labels - @ ]
. O Model Tree Layers
Read Out Loud » Rulers & Grids » (n} GD odel T
; ) ZZ, Order 8 Model Tree
Compare Files Cursor Coordinates @ 550 ) dor
Page Thumbnails =
» CYX Signatures @Eage Thumbnails
ETE— ]
#y Tags
Show Navigation Pane F4
Reset Panes Reset Panes

Hide Navigation Pane Buttons




Tags Pane, 1 of 2

Accessible PDF means every piece of content must be
tagged with the correct tag.

<H1-H6>
<P>

<>

ol Tags are invisible identifiers that will tell screen readersand | 3
g other assistive technology (AT) an object is... . T
— * Paragraphs of body text: <P> H -
* Headings and subheads: <H1> - <H6> ¢ e
e Lists: <L>, <LI> B > § <HI>
* Tables: <Table>, <TR>, <TH>, <TD> 35 ¥ <H2z
* Graphics have Alt-Text that describe the visual: <Figure> <
* Hyperlinks: <Link> z ?F
* Captions, and other parts of a document: <Caption> e
* Decorative images: <Artifact> > 4§ <H2>
Ensure the tags are in the correct logical reading order to match the 2l
document pane. z 2“




Tags Pane, 2 of 2

N @S 3O B

&

= Universal Design Center

A4 0 <H2>

= | Accessibility Statement

vﬂ«.j‘)

= | As part of our commitment to
v a <H3=>
= | Meed help?
> ﬂ <P>
> ﬂ «P=
> a <H2>
> ﬂ <P>
> a <Figure>

Universal Design Center

Accessibility Statement

As part of our commitment to excellence through diversity and inclusion, California State
University, Northridge (CSUN) strives to ensure that campus communication and information
technology is accessible to everyone. The California State University system statement on
accessibility is articulated in California State University - Executive Order 1111, in accordance
with both federal and state laws including the Americans with Disabilities Act of 1990 (ADA) and
Section 508 of the U.S. Rehabilitation Act.

Need help?

Need assistance or have a question not answered here? Please contact the
Universal Design Center (UDC) at UDC@ csun.edu or, during business hours (Monday
through Friday, 8am to 5pm Pacific time), at (818) 677-5898.

‘What is Accessibility? What is Universal Design?

In this context, “accessibility” means that people with disabilities have access — to facilities, to
information and to technology. “Universal design” takes this concept one step further, to
ensure that everyone can perceive, understand, engage, navigate and interact regardless of
ability or preference.

Figure 1: Accessibility logo

Tags are shown as an
expandable “tree”

 Up and Down arrow keys to
navigate tags tree.

e Right and left arrow keys to
expand and collapse the text.




What is Custom Tags?

I} Autotag Document

Reading Options
) Full Check

@ Accessibility Report
I;k Identify Form Fields

Set Alternate Text

“\ Setup Assistant

Reading Order

[=2]

Draw a rectangle around the content then click one %]

of the buttons below:

Text/Paragraph Figure
Form Field Figure/Caption
Heading 1 Heading 4 Table
Heading 2 Heading 5 Cell
Heading 3 Heading & Formula
Reference (q) ‘ ‘ Note (z) Background/Artifact

Tags such as Link, List, List Item,
Table Data Cell, Table Header
Cell, Section, and so forth that
are not listed in the Reading
Order tool, but these are
essential structural elements.

Custom tags are the only way to
make it works by selecting “New
Tag” from Tags Pane.

When do we use custom tags?

niversal ' esign ' _enter
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How to Tag a Document?

. Open Accessibility, select Reading Order Tool

. Draw a rectangle around the content or double-click the content

1
2
3. Select one of Reading Order buttons to tag it
4

. Proceed step #2 to tag the rest of the content

I} Autotag Document

Step 1

@ Accessibility Check
@ Accessibility Report
':& Identify Form Fields
Set Alternate Text

’\ Setup Assistant

~

Accessibility Statement

Universal Design Center | Step 2

As part of our commitment to excellence through diversity and inclusion, California State

University, Northridge (CSUN) strives to ensure that campus communication and information
technology is access|b|e toeverinona Tha Califarnia S+ata | lnivarcitu cvctam ctatamant an

accessibility is articulated i
with both federal and state

E” Reading Order

Section 508 of the U.S. Rel Step 3 the bt Do enetxkene ot e
|U‘n|iv|e rsa|| |D)e|sig|n| C|e|n|t)er e —
Form Field Figure/Caption
Accessibility Statement T | Eve—— o
As part of our commitment to excellence through diversity and inclusion, California State © Heading2 | | Heading5 Cel
University, Northridge (CSUN) strives to ensure that campus communication and informatior Heading 3 Heading 6 —

technology is accessible to everyone. The California State University system statement on
accessibility is articulated in California State University - Executive Order 1111, in accordance
with both federal and state laws including the Americans with Disabilities Act of 1990 (ADA)
Section 508 of the U.S. Rehabilitation Act.

Reference (qg) Note (z) Background/Artifact

Table Editor




List Tags

How do we create list tags?

How to create an accessible PDF:
* Create an accessible Word document
* Convert your Word document to PDF
* Validate PDF Tags and Reading Order
* Use the accessibility checker to test your document

niversal —esign _enter csun.edu/udc



List Tags

] Tags Panel: Create New Tags L —
Type: List -
 List Nesting: | e |
List <L> [ o< ][ comca |
List Item <LI>
List Item Body <LBody> v @<L
List ltem <LI> v @ <>
List ltem Body <LBody> > 4 <LBody>
List Item <LI> v @ <>
List ltem Body <LBody> > 4§ <LBody>
v @ <Ll>
> &F <LBody>
v @ <Ll>
> 4§ <LBody>




List Nesting, 1 of 2

List Tags

How to create an accessible PDF:

e Create an accessible Word document
e Convert your Word document to PDF
e Validate PDF Tags and Reading Order

e Use the accessibility checker to test your document

1 [H1st Tags

‘@ow to create an accessible PDF:

‘@ Create an accessible Word document ‘

| Convert your Word document to PDF

E Validate PDF Tags and Reading Order

@ Use the accessibility checker to test your document

v @ Tags

5 {5 <H1>

pY ﬂ-ﬁP:a

vﬂ-:P:»

= N Create an accessible Word document

vﬂ-:P:»

=N Convert your Word document to PDF

vﬂ-:P:»

= N Validate PDF Tags and Reading Order

3

* List item needs to tag <P> line by line
individually not one chunk <P>

* Hold Shift key to select four <P> at
the same time

* Right-click Properties
* Change Paragraph to List Iltem Body

Note: CTRL is for specific selection

Object Properties

Content Tag Color

Type: Paragraph

Label
Title: |Link
List

Actual Text: |List ltem

MNote

Alternate Text:
Part

Quote

Paragraph

Reference

List Item Bodh

Language: |

Edit Tag...

Edit Attribute Objects...

Edit Attribute Classes...

Close




List Nesting, 2 of 2

w @ <|Body=>
= N Create an accessible Word document 5
w @ <|Body=>
= N Convert your Word document to PDF
v @ <LBody=>
= Validate PDF Tags and Reading Order
v @ <|Body=>

B Use the accessibility checker to test your docume...

MNew Tag 7 X
Type: Article ~
] Label ~
Title: Link

|: List

List Item Body -

New Tag...

IH - CUI
v § <8 Delete Tag
Delete Empty Tags

v § <18 Reading Order ()

B Find Tag from Selection
v §f <8 Create Tag from Selection
Eind...

Copy Contents to Clipboard

Mote
Paragraph
Part
Quote

Reference

Create 4 new List Item <LI>
tags and 1 new List <LI>.

New Tag 8 X

Type: List | ~
) Index e
Title: Label

|: Link

List ltem Body
MNote
Paragraph
Part

Quote

List Item -

> @ <H1=

> @ <P> 9
@ <L

@ <Ll>

@' <Ll=

@ <Ll

4 <U>

> § <lBody>
> § <LBody>
> 4§ <LBody>
> §f <LBody>

Hold Shift to select all four
<LI> move underneath <L>.
<L> becomes the parent

and <LI> becomes the child.

b) q'|<P>

—E 110
521'}
& <>
& <>
& <U>
> F <LBody>
> F <LBody>
> F <LBody>

> @' <LBody>

> @ <LBody=>
S @ <LBody>
S @ <LBody>

Move each <LBody> under <LI>. All
list items should look like this format.

> q‘|<P>

v § <L
L 12

v @ <LBody>
E N Create an accessible Word document
) @' <Ll>
v @ <LBody>
= N Convert your Word document to PDF
N @ <Ll=
v @ <LBody>
E N Validate PDF Tags and Reading Order

v @' <Ll=

v @ <LBody>

= N Use the accessibility checker to test your docui




Links or Hyperlinks

Adobe: Create and Verify PDF Accessibility
* Link TagS NCDAE: Creating Accessible PDF Documents

° Create I_| N k Coblis Color Blindness Simulator

Simple Tables vs. Complex Tables
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https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
http://www.ncdae.org/resources/cheatsheets/acrobat-xi.php
http://www.color-blindness.com/coblis-color-blindness-simulator/
http://accessibility.psu.edu/tables/

Best Practices for Accessible Links

PRESENTATION FUNCTIONALITY

DESCRIPTION

* Link functionality is about
ensuring a link functions the way
the user expects.

* Each link on the page should
be visually different from
regular text on the website.

* Link text must always properly
describe the purpose of the link
and tell a user where the link will

take them. * Links must always enhance the

accessibility of a webpage.

* Can be differentiated by color,
bold, underline, or italics.

* Do not use text such as “click
here” or “read more,” nor web
addresses (URLs).

* Users must be able to access
links using a mouse, keyboard, or
speech recognition commands.

* Using color alone does not
make it accessible.

LINKED IMAGES

n * Alinked image is an image (with or without text) that is linked to another resource or webpage. n
l * Linked images need link descriptions as well as image descriptions (alt text). '
U * If the link description is different than the alt text, enter the link description in the HTML Title field. U

e Visit Linked Images on the Best Practices for Accessible Images page for more information.



https://www.csun.edu/universal-design-center/best-practices-accessible-images#LinkedImages

Link Tag

J Tags Panel: Find Unmarked Links

J Link Nesting:

= “OBJR” tag must be present so link is
defined correctly

G <Lin

ﬂ:ff Link - OBJR

k=

Find Element

Find: |Unmarked Links

Type: Mone

(@) Search Page

Find

(") Search Document I

Tag Element Close ‘

niversal ' “esign ‘_enter
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Link Tags 1

Universal Design PowerPoint Accessibility

Adobe: Create and PDF Accessibility

California State University, Northridge

This example has no tag structure

v Tags
" 5.n  Hold CTRL key
' or... then select all
’:’_ 7 <P> tags
v 4 < >

Eii Universal Design PowerPoint Accessibility

H Adobe: Create and PDF Accessibility

4

g California State University, Northridge

Create Link, 1 of 3

Hijnk Tags 2

[@niversa[ Design PowerPoint Accessibility |

| : dobe: Create and PDF Accessibilitg |

Eb]ifornia State University, Northridge |

New Tag...

Cut

Delete Tag 5

v @ Tags
v @ <H1>
= | Link Tags
v q <P>
= | Universal Design PowerPoint Accessibility
v € <P>
= | Adobe: Create and PDF Accessibility
v € <P>

— California State University, Northridge

Object Properties

Delete Empty Tags

Reading Order (x)

Content| Tag

‘ Color ‘ 6

Find Tag from Selection
Create Tag from Selection Type:
Eind...

Title:
Edit Class Map...

Edit Role Map...
i Actual Text:

Tag Annotations

v Document is Tagged PDF

Paragraph H

Heading Level 5
Heading Level 6
Index
Label

List !g ‘

List Item

v Apply Role Mapping to Tags
v Highlight Content

Properties... k:




Create Link, 2 of 3

v @ Tags
v @ <Hl>
. Link Tags
v @ <link>
. Universal Design PowerPoint Accessibility
v @ <link>
. Adobe: Create and PDF Accessibility
v @ <Link>

. California State University, Northridge

3 £

Link Tags 9

Universal Design PowerPaint Accessihility

Copy

Copy With Formatting
Adobe: Create :

Edit Text

; . Export Selection As...
California State

Highlight Text
Strikethrough Text

Add Note to Replace Text
Add Note to Text

Add Bookmark

Create Link...

Look Up "Accessibility"

Close Accessibility
I-_% Autotag Document

Highlight “Universal Design
PowerPoint Accessibility” then right
click to select Create Link

Create Link

Link Appearance

Link Type: lInvisibIe Rectangle

'] Line Style: | Solid v

! Highlight Style: [None

vl Color: W

Line Thickness: | Thin

Link Action
() Go to a page view
(©) Open a file

@ Open a web page

-

10

ven | [ |
Edit URL . am -
Enter a URL for this link: 1 1
https://www.csun.edu/universal-design-center/PowerPoint A
l OK ] I Cancel




@ <Link:=

@ Link - OBJR

“OBJR” tag must be present
so link is defined correctly

> @ <HL> 12

& Yl New Tag...

v @ <Link Cut
B A Delete Tag

v @ <l Delete Empty Tags
o G

Reading Order (x)

Eind... [%

Copy Contents to Clipboard

Create Link, 3 of 3

Find Element

Find: |Artifacts

ol ™

1 3 Artifacts
Unmarked Comments

il Unmarked Links

s Unmarked Annotations
Unmarked Content
OCR Suspects

Find I

Tag Element

l

Close

Find Element

E3

[=1i% Al Unmarked Links -

Type: None

@ Search fle  (©) Search Document

Tag Element Close

........

> @ <Hl> 16

@ Link - OBJR

= | Universal Design PowerPoint Accessibility

v @ <Link>

@ Link - OBJR

= | Adobe: Create and PDF Accessibility

v @ <Link>

@ Link - OBJR

= | California State University, Northridge

Find Element

Find: [Unmarked Links

L I

15

Type: Link
@ Search Page () SearcgfDocument
[ Find Next ] [ Tag Element Close

Autotag Document

Reading Options

Full Check

B A &|o|E

| s

Accessibility Report
Identify Form Fields
Set Alternate Text
Setup Assistant

Reading Order




Tables

Visual 1.8 Million

Hearing 1.0 Million

Cognifive Menial 4.3 Million

Ambulatory 11.8 Million
e Table Tags

* Table Editor
* Table Summary

niversal —esign '_enter csun.edu/udc



Table Header Cells - Office

1. Table Tools added to the Ribbon when Table is created or selected

2. Header Checkboxes found under Design Tab
 Word

 Header Row (Column Headers)
* First Column (Row Headers)

Home Insert Draw Design Layout References Mailings Review View ACROBAT

| Header Row ” First Column | ] [ oy oy py oy N o e ey T o o {%

D Total Row D Last Column

L[]
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
{

—f =l=l=l==] === === = == s Shading Border

Banded Rows D Banded Columns

Styles ~
Table Style Options Table Styles
Fruit 2018 2017 2016 Fruit 2018 2017 2016
Orange $1,900 $2,400 $1,500 Orange $1,900 $2,400 $1,500
Strawberry S800 S600 51,000 Strawberry S800 S600 51,000
Avocado 52,000 51,500 53,000 Avocado 52,000 51,500 53,000

Header Row (First row header) Header Row and First Column



Table Header Row - Office

If ‘Repeat as header row at the top of
each page’ isn’t selected, table headers
will be ignored when exporting as a PDF
and won’t be read by screen reader.

* Right-click the first row of the table and
select Table Properties.

* On the Row tab, make sure the checked
Repeat as header row at the top of each
page and unchecked Allow row to break
across pages. Click OK.

* Repeat these steps for all tables in the
document. Save the document.

_
pi—
pamy

Cut
Copy
Paste Options:

il il il
=

& 4 A

Insert »
Delete Table

Distribute Rows Evenly
Distribute Columns Evenly
Border Styles »
AutoFit »

Text Direction...

Insert Caption...

Table Properties...

oGl =

MNew Coﬁ’nent

,Table Properties { % -5 |
‘ Table Row Column Cell Alt Text |
Rows 1-4:
Size
Dgpecifyheight: 0" “I| Row height is: | At least -
Options

DEAIIOW row to break across pages

Repeat as header row at the top of each page

l 4 Previous RowJ l w Mext Row

niversal ' esign ' _enter
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Table Editor, 1 of 2

1. Set up Table Editor

e Access via Tag Tree or Reading Order tool
e Set display color options

2. Enhancements
* Click anywhere
e Select cell

:

Table Editor Options
il

TDme

DTitle

Dte Sharron

TDPr'ogram Manager

TD| Roles & Responsibilities

@ Jane of all trades

Color Options
Border color
Header cell color
Data cell color
Selection color

Show cells that span multiple rows or columns

ONDOENEN

Show cells with missing header

Label Option

Show cell type (TH or TD)

OK ‘ ‘ Cancel

L@Ln Davoudian

@Senior' Information System Analyst

@ Web Accessihility

TDUstal Monroy

Oproject Analyst

1D Procurement Accessibility

I_[jn Nguyen

TD

Instructional Media Accessibility

m Document Accessibility

IEIra rdo Rodriguez

@Tech nical Consultant

@ Web Accessihility




Table Editor, 2 of 2 a

Table Cell Properties...

m_q__g y Table Editor Options...
* Access from Tag Panel Option Menu =:b“'“*”‘ Auto Generate Header Cell IDs

* Right-click <Table> to select Table Editor (q)

Table Editor Dptionsl. - ﬁ
. L]
SEt U p OpthnS Color Options
Taas New Tag...
* Check all check boxes 2 Border color u
. Cut Header cell color [ ]
°
Select display colors B0 Satn cell color -
Selection color D
v @ Tags )
Delete Tag Show cells that span multiple rows or columns ﬁ
v ﬂ <Sect> Delete Empty Tags Show cells with missing header O
<H1> ;
> G Reading Order (x) LBl Sir ien
> [ <Table> Table Editor (q) Show cell type (TH or TD)
<P> Find Tag f Selecti
> ind Tag from Selection = ‘ ‘ Cancel ‘
Create Tag from Selection

niversal —esign '_enter csun.edu/udc



Table Tags

Tables need a <Table>, <TR>, <TH> and <TD> tags in this order

<Table>

<TR>: Table Row
<TH>: Table Header

<TR>: Table Row
<TD>: Table Data

Column and Row Headers need to be tagged with the <TH>
and data cells with the <TD> tag.

DE <Tablex=
** Use CELL to tag individually if Table 8 <TR>

. e <TH>
creates the tags incorrectly.

e <TH>
=28 <TR>
[ml= ":TD:’

[ml= "\-'.TD.?'

Reading Crder

the buttons below:

Draw a rectangle arcund the content then click one of %

Text/Paragraph Figure
Form Field Figure/Caption
Heading 1 Heading 4 Table
Heading 2 Heading 5 Cell
Heading 3 Heading & Formula
Reference (g) Mate (z) Background/Artifact
Table Editor
[+] Show page content groups [ |
() Page content order
(®) Structure types
[+] Show table cells [ ]
[ ] Display like elemnents in a single block
[“] Show tables and figures [ |
Clear Page Structure... Show Order Panel
Help Close




<TD> tag

Fixing Tags — Basic Table, 1 of 2

Column and Row Headers need to be tagged with the <TH> and data cells with the

* Open Table Editor (context menu in Tag Tree or Reading Order tool)

* Notice row headers (Orange, Strawberry, Avocado should be <TH> not <TD>)

 Select 1 or multiple <TD> tags change to <TH> tags

Fruit 2018 2017 2016
Orange $1,900 $2,400 | $1,500
Strawberry S800 S600 51,000
Avocado $2,000 $1,500 | $3,000
THuUt ™H 2018 | [H 2017 | [H 2016
[:?; nge ™ $1,900 | [10$2,400 | [10$1,500
rawberry ™  $800 | [ $600 | [D$1,000
Drocado ™ $2,000 | [1D/$1,500 | [TD$3,000

z
©

w Tag...

0
=
=3

Delete Tag
Delete Empty Tags

Table Editor

Find Tag from Selection
Create Tag from Selection

Find...
Copy Contents to Clipboard

Edit Class Map...
Edit Role Map...

Tag Annotations
v Document is Tagged PDF

v Highlight Content

Properties...

> \j <H3>
> ﬂ <P>

v [f <Table>

y =5 <TR>




Fixing Tags — Basic Table, 2 of 2

v E <Table> L Object Properties @l
> B TR cut |C0ntent|Tag |COI0r |
v B5 <TR>
* Hold Ctrl and select =05 i:t :ﬂ‘-‘pwgs tpe Tabe ot el ]
mu|t|p|e <TD> tags S &g <1D> | Title:  Section
> EE <TD- reading rder () Actual Text: 'SFEZIne
* Right-click to select s &8 <T0> find Tag from Selection Table Data Cell
H Create Tag from Selection &
Propertles v 55 TR Find... Alternate Text Table Of Contents Item ‘;‘
S B =1D= B Table Row |
* Change Table Data Cell B Edit Class Map.. | -
to Table Header Cell > &6 <D e fele Hep- — .
> EJ <D= Tag Annotations
gl ==< <TR> v Document is Tagged PDF Edit Tag.. Edit Attribute Objects... Edit Attribute Classes...
> EH s v Apply Role Mapping to Tags
y Bf <ID> v Highlight Content —
> Eg <TD> Properties... §=
> B <1D>
THujt H 2018 | [H 2017 | [+ 2016 T it i Roag[[[H 017[[][+ 2016
nge ™ $1,900 | [1$2,400 | [ri$1,500 TH inge o [$1,900( [l62,400]| [rls1,500
TDrawberry D S800 | [TO S600 | [DS1,000 THr awberry E $800|| [ [$600]|| [DI$1,000
Dlgead ™ $2,000 | [19$1,500 | [rl$3,000 THy ycado ™ $2,000| [D$1,500( [10|$3,000




Table Summary

i

 What is a table summary? foble Sunany

Table Summary:

A table summary is really similar to
alternative text for images. It’s a
description of what your table
represents. -

| ‘ Cancel

* Do | need a table summary?

niversal —esign _enter csun.edu/udc



Tables Issues / Accessibility

e Table issues are unpredictable
* Problems with tables converted from Word or other programs
* May need to fix tables in Tags Panel

* To ensure accessibility, format tables with headers and avoid merged,
split, or blank cells

 The more complex a table (merging cells, nesting multiple headings
under one, adding blank lines, etc.) the worse it will be for accessibility

* Sample of Simple Tables vs. Complex Tables by Penn State

niversal —esign _enter csun.edu/udc


http://accessibility.psu.edu/tables/

Check Accessibility Again...

Go through each section that has one or more issues/failed to fix it until all sections passed.

Two question marks @ will always stay in Document (2 issues) section even if you right-click and

select Pass. It just there as a reminder to conduct manual check.

&7

Autotag Document

Reading Options

Full Check

Accessibility Report
Identify Form Fields

Set Alternate Text

/A B 4 @0 H

Setup Assistant

Reading Order

Accessibility Checker Options

Report Options

[] Attach report to document

Page Range

(@) Al pages in document

Checking Options (31 of 32 in all categories)

Create accessibility report Folder: C\Users\sem72178\Documents

() Pages from ’2_ to ’2_

Category: IDocumant

[¥] Accesst

ity permission flag is set

Document is not image-only PDF

Document is tagged PDF

Document structure provides a logical reading order
[¥] Text language is specified

Document title is showing in title bar

Bookmarks are present in large documents

Document has appropriate color contrast

Show this dialog when the Checker starts

Start Checking l [ Cancel

S

Accessibility Checker x
e Document (4 issues)
o Accessibility permission flag - Passed
4 Image-only PDF - Passed

@ Tagged PDF - Failed

Logical Reading Order - Needs manua

o Primary language - Passed
@ Title - Failed
«# Bookmarks - Passed

.{'v Color contrast - Needs manual check

3 Page Content (2 issues)
> Forms
~ Alternate Text (5 issues)

(;. Figures alternate text - Failed

) Nested alternate text - Failed

@ Associated with content - Failed

(;. Hides annotation - Failed

> @ Other elements alternate text - Faile

> Tables (4 issues)
> Lists (2 issues)
~ Headings (1 issue)

) Appropriate nesting - Failed

(&
W
@

o

Accessibility Checker X

=]~

~

Document (2 issues)
o Accessibility permission flag - Passed
«# Image-only PDF - Passed
«# Tagged PDF - Passed
@) Logical Reading Order - Needs manual check
a# Primary language - Passed
a# Title - Passed
o Bookmarks - Passed
@) Color contrast - Needs manual check
Page Content
o Tagged content - Passed
«# Tagged annotations - Passed
¢ Tab order - Passed
o Character encoding - Passed
a# Tagged multimedia - Passed
o Screen flicker - Passed
o Scripts - Passed
o Timed responses - Passed
¢ Mavigation links - Passed
Forms
Alternate Text
Tables
Lists

Headings




Common Issues — Title shown as a failure

Acrobat did not recognize the Title from
Word Document, simply right-click Title item
and select “Fix”.

The document description gives the
document a proper title and language to be
recognized by assistive technology.

e Select File menu > Properties

* Description tab, enter Title box is
document title or main content
heading/title (deselect Leave As Is, if
necessary).

* Application box showing the source
document created from Word to PDF.

&

@ND(%@Z]

Accessibility Checker
El -
v Document (3 issues)
Accessibility permission flag - Passed
Image-only PDF - Passed
Tagged PDF - Passed
c Logical Reading Order - Needs manual check
Primary language - Passed
Bookmarks - Passed

.5 Color contrast - Needs manual check

Bookmarks

) Skip Rule
&4 Color contr
-

Explain
Page Content

Document Properties

Description ‘Secunty i Fonts ilnmal View | Custom I Advanced

Description

File: Creating Accessible Documents_Hand_Out.pdf

Tite: |

Author: ‘Umversal Design Center

Subject: ‘

Keywords:

Created: 1/11/2019 11:47:41 AM

Modified: 1/11/2019 11:47:43 AM

Application: Acrobat PDFMaker 19 for Word

PDF Producer: Adobe PDF Library 19.10.96
PDF Version: 1.6 (Acrobat 7.x)
Location:  C\Users\hbecs137\Desktop\
File Size: 213.54 KB (218,662 Bytes)
Page Size: 850x11.00in

Tagged PDF:  Yes

Number of Pages: 5

Fast Web View: Yes

Additional Metadata.

Help

OK Cancel




What are PDF Title and Language?

Title

* A PDF title is a more descriptive and
meaningful version of the file name. PDF
titles are often visible in the PDF window or
tab. This visibility makes it easier to
distinguish multiple PDFs before diving in.

 When multiple PDFs are open, well defined
PDF titles allow for easier distinction
between them. This distinction is particularly
useful when relying on screen readers.

Accessibility 101

Word Essentials

Il
Ally Demo Tools

Language

Screen readers can "speak” various
languages—as long the content
language is identified. If the screen
reader does not support or cannot
speak the defined language, the user
might be informed of the content
language, even if that content cannot
be properly read.

WebAIM: Document and Content Language

TIpUBET

ZhichlE



https://webaim.org/techniques/language/

Accessibility Checker — Manual evaluation

The accessibility checker will always

flag two items that require manual
evaluation:

* Logical Reading Order
e Color Contrast

Two question marks @ will always stay in
Document (2 issues) section even if you
right-click and select Pass. It just there as
a reminder to conduct manual check.

niversal ' esign ' _enter
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Accessibility Checker

IE'.

A

>

Document (3 issues)

Accessibility permission flag - Passed
Image-only PDF - Passed
Tagged PDF - Passed

'-u-' Logical Reading Order - Needs manual check

Primary language - Passed

@ Title - Failed

Bookmarks - Passed

'-u-' :!Color contrast - Needs manual checlcé

Page Content

csun.edu/udc



Verify Logical Reading Order

Ensure the TAGS Tree are in the correct logical order to match the document pane. Manual rearrange tags as
needed in the TAGS pane. After making these adjustments, start from the top of the tags tree and move
through the tags pane sequentially using the down arrow key. A logical reading order start from left to right,
top to bottom as illustrated. The Document Pane example is a two-columns layout hence the logical reading
order starts with the first column then second column.

2 ]
(8 . Left: Incorrect
4 | G reading order
@ ]

Bottom: Correct
| reading order

@ © 306

Tags

&

E-©

~ o <Document:

Tags Tree

|Universa| Design Center

v <j <Art>
v <Sect> This site is a project of the Accessible Technology
v @ Initiative (ATT) of the California State University

i system. “It is the policy of the CSU to make
L IW information technology resources and services
v @< accessible to all CSU students, faculty, staff and the

. e Ao general public regardless of disability”

H s siteis a project o € Accessible lec

All CSU programs, services, and activities should be
accessible to all students, staff, faculty, and the general
public. This encompasses all technology products

:.;,-! Initiative (ATI) of the California State Uniy|
=] system. “lt is the policy of the CSU to mak

used to deliver academic programs and services,
student services, information technology services, and
auxiliary programs and services.

= nformation technology resources and set

g general publ ic [y less of disability.”

> @z.b

> § <Figure> — Universal

> O <H2>
S e Center

v O <H2>

=] UDC Mission

> @

Accessibility Statement

UDC Mission

The UDC supports the campus community in

their efforts to make it possible for individuals to
learn, communicate, and share via information and
communication technology. One way we do this is

by assisting the campus community to ensure their
information and communication technology is
interoperable, usable and accessible, so that individual
learning and processing styles and/or physical
characteristics are not barriers to access.

Campus Responsibility
Everyone has a part in creating accessible and usable
information. The responsibility of creating and

maintaining accessible content falls to the entire
campus community.

Document
Pane




mColourContrastAna ar (CCA EEE
Colour Contrast Analyser (CCA) Edit View

Foreground colour

-----------------------------------------------------------

rgb(44, 44, 44)

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

__________________

¥ Sample preview

WCAG 2.1 results ! Contrast ratio
1.5:1

¥ 1.4.3 Contrast (Minimum) (AA) |

Text (including images of text) has a contrast
ratio of at least 4.5:1 for "regular” sized text and at least
3:1 for large scale text (at least| 12pt| /| 24px|, or bold
and at least | 1¢pt |/ [18. 5px ), unless the text is purely
decorative.

& Fail (regular text) @ Fail (large text)

¥ 1.4.6 Contrast (Enhanced) (AAA)

Text (including images of text) has a confrast

ratio of at least 7:1 for "regular” sized text and at least
4.5:1 for large scale text (at least | 12p< | /| 24px |, or bold
and at least | 14pt|/[12. 5px|), unless the text is purely
decorative.

Q Fail (regular text) Q Fail (large text)

¥ 1.4.11 Non-text Contrast (AA)

Paraphrased | The visual presentation of user interface

components (their states — including focus indication —
and boundaries) and graphical objects has a contrast
ratio of at least 3:1 against adjacent color(s)

| 0 Fail (Ul components and graphical objects)

People who have low vision or
colorblind could encounter some
difficulty distinguishing text color
from a background color if the
contrast is insufficient contrast ratio

1.5:1.

Colour Contrast Analyser (CCA) Edit  View

Foreground colour

RSN  rob0.0.0)

(=110

Background colour

#E69500

¥ Sample preview

-

example text showing contrast

¥ 1.4.3 Contrast (Minimum) (AA)

Text (including images of text) has a contrast

ratio of at least 4.5:1 for "regular” sized text and at least
3:1 for large scale text (at least|18pt |/ | 24px|, or bold

Contrast ratio

8.7:1

WCAG 2.1 results

and at least | 14pt|/|12.5px]), unless the text is purely
decorative.
() Pass (regular text) () Pass (large text)

» 1.4.6 Contrast (Enhanced) (AAA)

-

() Pass (regular text) () Pass (large text)

» 1.4.11 Non-text Contrast (AA)

{+) Pass (Ul components and graphical objects)

w= Verify Color Contrast

Bad Examples Good Examples
Yellow on black is good

Blue on orange is bad Black on orange is ok

White on green is good

Aqua on purple is ok

Download Colour Contrast Analyser onto
your computer (PC/Mac) to ensure
accessible contrast or use an online
contrast checker from WebAIM.

This example has a great color
contrast ratio of 8.7:1. The
contrast is sufficient for those
who have color deficiencies

WCAG Level AA requires a contrast ratio of
at least 4.5:1 for regular sized text (12 or
14 pt. font) and 3:1 for large text (18 pt.
font).

Coblis Color Blindness Simulator



https://www.csun.edu/universal-design-center/document-learning-tools#ColorContrast
https://webaim.org/resources/contrastchecker/
http://www.color-blindness.com/coblis-color-blindness-simulator/

Accessibility Tips

* Always save your PDF as you add accessibility
markup

* When modifying extensive content in reading
order, drag content down not up

* Remove empty tagsi.e. <p>
Accessibility Tips

 Header, footer, and page numbers, decorative
lines or shapes tag as “Background/artifact”

niversal —esign '_enter csun.edu/udc




PDF Accessibility Iterative Process

3
. . Review and
correct tags
. 4 40 48
Congratulations!

niversal ' esign '_enter csun.edu/udc



How can we help you make a difference?

@ Documents
| Online & Self-Paced

Accessibility

Modules
ncanvas ®

Make one Y
” design that
fits everyone

‘ L3 r ’ i

ﬂEﬂ @ Universal Design Center Offers
Media with - Wobeire * Online, self-paced training
captioning p * In-person training each semester

e Consultations

Universal Design means design for everyone * Tools and Services

niversal —esign _enter csun.edu/udc
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